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Changes and Enhancements

Introduction
This section describes the features of SAS software under Windows that have been

implemented or enhanced since Release 6.12. Version 8 changes and enhancements are
preceded by . All other changes and enhancements described in this section were
included in Version 7. If your site upgraded directly from Version 6 to Version 8, then
all of the changes and enhancements described here are new to you. If you upgraded
from Version 7 to Version 8, then only the items preceded by are new to you. For
information about changes and enhancements to base SAS software, see the base SAS
documentation. For information about changes and enhancements to other SAS
products, see the documentation for those products.

Graphical User Interface
For information on using the graphical user interface (GUI), see “Overview of the

SAS System Interface” on page 27 and “Printing” on page 125. Some of the GUI
features include

Docking View
The Docking View allows for easy navigation within SAS by integrating certain
windows, such as the Explorer window and the Results window, into the left side
of the main SAS window. Files that you open from the docking area open as a
separate window in the remaining SAS workspace. You can undock individual
windows if you prefer.
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pull-down menu enhancements
The Local, Global, and Options pull-down menus have been removed.

You can use the View menu to access the Program Editor, Enhanced
Editor, Log, Output, Graph, Explorer, Results, and My Favorite Folder
windows.

You now set options and customize tools from the Tools menu. The Tools
menu also provides access to various SAS editors.

When an editor is the active window, you can use the Run menu to submit SAS
programs either locally or remotely.

The Solutions menu provides access to applications for analysis, presentation,
program development, reporting, and accessories.

Also, icons are associated with some of the menu items.

pop-up menu enhancement
There are now more places within the main SAS window that have pop-up menus
when you click the right mouse button.

command bar enhancements
SAS remembers commands that you have entered from previous SAS session. If
you type a command, SAS recognizes the command and automatically completes
the command for you.

toolbar enhancements
Using the Customize Tools dialog box, you can add, delete, and modify tools on the
toolbar as well as specify the help and screen tip text to display.

Window Bar
The window bar displays a button for each open window within the main SAS
window. You can easily make a window the active window by clicking on the
window’s button on the window bar.

Microsoft IntelliMouse support
SAS supports Microsoft IntelliMouse, which is a modified mouse that includes a
wheel used for scrolling. Support for IntelliMouse also includes AutoScroll.

Page Setup dialog box
The Page Setup dialog box lets you interactively define global settings for paper
orientation, margins, paper size, and paper source, instead of defining these
settings for each printer from the Print Setup dialog box.

Print dialog box
Using the Print dialog box, you can select a printer, the window, number of copies,
and page range you want to print. You can also specify if you want to print the
output as a bitmap or to print to a file.

Print Preview utility
This utility enables you to see what your printed output will look like before you
print the file.

Preferences dialog box enhancements
The Preferences dialog box categorizes settings on different pages:

General page
contains settings for listing recently used files in the File menu, exit settings,
submitting the contents of a file when it is opened, and e-mail options.

View page
has settings for window components that you would like available in the
main SAS window, such as scrollbars, command line, docking view, window
bar, and status line.
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Edit page
has options for the overtype mode, autosave features, unmarking with
navigation keys, and using the Enhanced Editor.

Results page
has options to select HTML and conventional listing output.

Web page
is where the user defines their preferred Web browser and the Web page to
open when the Web browser is invoked.

Advanced page
contains scrolling options for the Output and Log windows as well as options
to hide the cursor in non-input windows and to disable focus on scroll bars.

viewing SAS System Help using Microsoft HTML Help viewer
When Microsoft Internet Explorer 4.0 or above is installed, the SAS System Help
in HTML displays in a window independent of your web browser.

web enhancements
Certain windows, such as the SAS Explorer window, can have a web look and feel
when Microsoft Internet Explorer 4.0 or above is installed. The web
enhancements, enabled with the WEBUI system option, let you point the mouse
cursor to select an item and a single-click to invoke the default action.

Basic Operation of the SAS System
The basic operation of the SAS System under Windows has been enhanced as follows:

Silent (unattended) Setup
Improvements to Silent (unattended) Setup allow it to be used for remote,
unattended installations.

multiple-user support
To facilitate multiple users on the same computer, the Setup program allows users
to use separate SASUSER locations. Since these folders are placed in locations
that are separate from the main SAS System image, network installations can be
shared more easily.

CD-ROM browser
The Auto-run program that launches when the SAS System CD-ROM is inserted
has been enhanced. It now provides a custom Web view of the SAS System
CD-ROM. Microsoft Internet Explorer 3.02 (or above) users will also see a custom
Web view of the SAS CD-ROM that facilitates its use with Internet Explorer.

multiple-installation support
Setup now handles separate invocations. A single uninstall action correctly
removes all previously installed SAS System files.

Setup dialog box selections
The Setup dialog boxes have been reorganized so that Personal, Client, and
Server installations can be more easily selected and performed.

network performance
SAS configuration information has been better organized so that performance
across a network is improved.

enhanced configuration file processing
Multiple configuration files are now allowed as well as embedding the CONFIG
system option within a configuration file. In addition, the SAS System will
automatically search several locations for configuration options.
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printing enhancements
Printers are now identified using the printer name, and you can print to any
printer defined to the Windows Print Manager. You no longer need to specify a
port name. Additional improvements to printing include new options that provide
programmatic control of settings that were previously available only in interactive
dialog boxes.

Enhanced Editor
Using the Enhanced Editor, you can now use color coding to differentiate SAS
statements, check the syntax of your SAS System programs, as well as edit
multiple files simultaneoulsy.

Program Editor enhancements include
� The CTRL+DELETE key deletes the current word instead of the whole line.
� Using the ALT key when you hold the mouse button selects a rectangular

block of text.
� The SHIFT key in combination with the mouse button extends the selection

of a text area.
� When you are copying text to the clipboard, the text stays selected after the

copy.
� When you are pasting text into the Program Editor while text is highlighted,

the highlighted text is replaced with new text.
� The Sasfont bitmap font displays faster and looks better on the display, so it

is the default display font. The SAS Monospace font looks better in printed
output and scales to many point sizes, so it is the default printer font and
RTF clipboard font.

Rich Text Format support
The contents of a text window can be saved as an RTF file using either the Save
As dialog box or the WRTFSAVE command.

dialog boxes
For dialog boxes such as the Open or Save As dialog boxes, file types and filenames
are associated with the window that invokes the dialog box. These changes allow
the window that invokes the dialog box to set the default file type and filename.

The DLGOPEN command has been enhanced to extend support for complex
filters, which include filters with spaces and single quotation marks.

font scripting
The capability to specify the script (codepage) to be used with a font is a new
feature. With this feature, you can use fonts that have codepages other than the
default codepage currently used by the SAS System. Font scripting is useful for
international SAS users who use more than one character set at a time. For
example, users can now create SAS/AF FRAME entries that use a Cyrillic, Greek,
and Western European font at the same time.

OLE enhancements
The OLE automation server can access data that exists on a remote machine using
Distributed COM Configuration Properties.

Operation on Windows NT
In addition to benefiting from features that are specific to Windows NT, such as the

64-bit capabilities of NTFS and symmetric multiprocessing (SMP), the SAS System
takes advantage of several other capabilities in the Windows NT operating environment:
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performance enhancements
The SAS System takes advantage of NT features that improve the performance of
input and output in the Windows NT operating environment. These include
optimizations for both sequential and random I/O, and taking advantage of
symmetric multiprocessing (SMP) in multi-processor machines.

SAS benefits from SMP capabilities as larger amounts of read-ahead processing
is done when operating on procedures that do large amounts of sequential data
access for data stored on Windows NT Server. This occurs more on systems with
extra processing power to service NT and its disk cache.

In addition, SAS System executable images are “based” to allow optimal loading
in the Windows NT virtual memory space to provide faster load times.

For large data processing requirements, greater throughput performance can
be achieved using the Scatter-read/Gather-write I/O processing.

If your server uses the Pentium II Xeon processor, the SAS System can access
memory beyond the 4 gigabyte boundary. Extended Server Memory Architecture
(ESMA) memory can be used as a very large disk cache or an in-memory library.

For more information, see “SAS System Features that Optimize Performance”
on page 153.

monitoring tools
Version 8 takes advantage of Windows NT system utilities, such as Performance
Monitor and Event Log, for more accurate diagnostics and monitoring when
deployed in a distributed server environment. For more information, see
“Overview” on page 177.

additional 64-bit file system support
More procedures take advantage of the 64-bit filesystem support that is available
under NTFS.

higher RAM limits
The SAS System takes advantage of 4-gigabyte tuning that is available in
Windows NT Server 4.0, Enterprise Edition. This allows SAS System applications
that require large amounts of virtual memory to directly access up to 3 gigabytes
of RAM in large server systems.

Application Integration
In addition to communications made possible with pipes, DDE, and external DLL

access, more support is now available in

e-mail
Enhancements to e-mail include added support for Microsoft Exchange Server. For
more information, see “Introduction to Using Groupware with the SAS System” on
page 161.

Lotus Notes
Lotus Notes support has been improved so that SAS System output can be exported
with formatting information, such as line breaks, retained. Report output can now
be directly exported to Lotus Notes for groupware sharing without changing the
report format that was generated. For more information on using Lotus Notes, see
“Introduction to Using Groupware with the SAS System” on page 161.

Open Database Connectivity (ODBC)
Two ODBC drivers are available under the SAS System under Windows, the SAS
ODBC Driver and the Universal ODBC Driver.

The SAS ODBC Driver is included in the base SAS System. It provides read
and write access to ODBC data for both local and remote (requires SAS/SHARE



xii Changes and Enhancements

and SAS/SHARE*NET) SAS servers to retrieve and update SAS data. The SAS
ODBC Driver allows the use of variables names up to 32–bytes as well as the use
of name literals. For more information on installing the SAS ODBC Driver, see the
installation documentation for the SAS System under Windows. For more
information about configuring and using the SAS ODBC Driver, see SAS ODBC
Driver User’s Guide and Programmer’s Reference.

The Universal ODBC Driver enables other applications to access SAS data
without requiring access to the SAS System. The Universal ODBC Driver provides
read-only access to ODBC data.

The Universal ODBC Driver is significant because it enables other applications,
such as Microsoft Excel, to directly access data stored in SAS formats without
requiring the SAS application software. For organizations that store large
amounts of SAS data on PC networks, this driver opens up the server data to more
applications than ever before.

The Universal ODBC Driver is sold separately and operates only on Windows
platforms. The driver provides access to the standard data sources, including SAS
data sets, CFO Vision financial databases (FDBs), SAS multidimensional database
(MDDB) files, and JMP files. This driver also supports access to SAS data
generated on other platforms, such as UNIX and OpenVMS.

For more information on the Universal ODBC driver, see “Using the SAS
UODBC Driver to Access SAS Data from Other Applications” on page 103.

the SAS System Viewer
In addition to supporting both Version 6 and Version 8 SAS data formats, the
viewer has enhancements in

active document support
The SAS System Viewer can be activated from within other applications that
support the ActiveX Document interface (such as a Web browser) to provide a
more consistent interface across applications.

improved printing support
The Viewer now handles pagination that is embedded in SAS output files.
When these types of files are browsed, they can be correctly viewed and
printed. Margins, styles, headers and footers can be set to customize the
printed output. Additionally, both text and table information can be scaled to
allow more information to be printed per page. The settings are saved to the
SAS Registry to be used the next time a file is printed.

bookmark support
The Viewer provides additional support to bookmark text patterns for both
the text and table-based file types. A text pattern can be assigned a color to
stand out from the rest of the text. The patterns can be assigned prior to
opening a file and are saved to the SAS Registry.

workbook view support
When you are viewing multiple windows simultaneously, the Viewer allows
the selection of a tabbed workbook view to facilitate navigation. Normal
multiple window viewing is also available.

data set view support
The Viewer now provides support for switching between different views of a
data set. The formatted, unformatted, and variable information of a data set
can be viewed in the main SAS window. This provides additional support for
exporting or printing the view of the data.

export support
The Viewer provides support to export table-based file types to a file or the
clipboard. The supported export file formats are CSV (comma delimited), Text
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(tab delimited), and Formatted Text (space delimited). Portions of the table
may be exported, or the entire view of the table may be exported to a
text-based file.

data subsetting support
To facilitate the viewing of very large SAS data sets, the Viewer can be
configured to subset (filter) the number of records (observations) and the
sorted order, and process a WHERE clause if one is provided. This allows
much larger data files to be viewed without exhausting system memory. The
settings are saved in the SAS Registry and are used the next time that a file
is opened.

HTML help
The viewer now provides help in HTML format if Microsoft Internet Explorer
3.02 or above is installed. If Internet Explorer is not installed, help is not
available.

SAS Language Elements

The following SAS language elements have been enhanced:

Formats
The following SAS format and informat have been enhanced:

$HEXw. format
converts character values to hexadecimal values. The width range is increased to
1–32767.

$HEXw. informat
converts hexadecimal data to character data. The width range is increased to
1–32767.

For more information about formats, see “SAS Formats under Windows” on page 317.

Functions and CALL Routines

� The following SAS function has been enhanced:

COLLATE
generates a collating sequence character string. The 200-character restriction
has been removed.

� The following SAS functions and CALL routines are no longer supported:

� HOSTHELP

� CALL ANSI2OEM

� CALL OEM2ANSI

For more information about functions and call routines, see “SAS Functions under
Windows” on page 327.
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Macros
The following SAS automatic macro variables are new:

SYSCC
contains the current SAS condition code that SAS returns to Windows when you
exit SAS.

SYSMAXLONG
returns the maximum long integer value that is allowed under Windows.

For more information about macros, see “SAS Macro Facility under Windows” on
page 483.

Procedures
The following SAS procedure is no longer supported:

V5TOV6

For more information about procedures, see “SAS Procedures under Windows” on
page 355.

Statements
The following SAS statements are new:

SYSTASK
executes, lists, or terminates asynchrnous tasks.

WAITFOR
suspends execution of the current SAS session until the specified tasks finish
executing

The following SAS statements have been enhanced:

LIBNAME
associates a libref with a SAS data library, lists file attributes for a SAS data
library, and can concatenate libraries. The valid values for the engine-name
argument were modified:

� the V8 engine is the current BASE engine
� the V7 engine accesses Version 7 data sets.
� the V6 engine accesses data sets for Release 6.04 and Release 6.08 through

Release 6.12.
New host options for the LIBNAME statement include:
� SHORTFILEEXT
� LONGFILEEXT
� MEMLIB

FILENAME
associates a SAS fileref with an external file or logical file device. The FILENAME
statement now supports wildcard characters. Also, when the COMMPORT
option is specified, a new host option, DROPNULL, can be specified to discard null
bytes when received. When using pipes, the host-option CONSOLE can be used to
minimize the DOS window.
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For more information about statements, see “SAS Statements under Windows” on
page 371.

Commands
The following SAS commands are new:

DLGPAGESETUP
opens the Page Setup dialog box.

WATTENTION
displays the Tasking Manager window which allows you to select which SAS
process to terminate.

WAUTOSAVE
controls how often the SAS System automatically saves work from the editor
windows.

WDOCKVIEW
toggles the Docking View feature on and off.

WEDIT
opens an Enhanced Editor session.

WEXITSAVE
toggles the Save settings on exit feature on and off.

WHIDECURSOR
toggles hiding the cursor in non-input windows.

WNAVKEYUNMARK
toggles the setting to unmark text using navigational keys.

WRTFSAVE
saves a text window as a rich text format file.

WSCREENTIPS
toggles the ScreenTips on and off.

WWINDOWBAR
toggles the window bar on and off.

For more information about commands, see “SAS Commands under Windows” on
page 270.

System Options
The following SAS system options are new:

ENHANCEDEDITOR
specifies to enable the Enhanced Editor during SAS System invocation.

FONTSLOC
specifies the directory location of the files that contain the SAS fonts that are
loaded during the SAS session.

GISMAPS
specifies the name of the SAS data library that contains U.S. Census Tract maps
supplied by SAS/GIS software.

HOSTPRINT
specifies that the Windows Print Manager is to be used for printing.
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MEMCACHE
specifies to use Extended Server Memory Architecture (ESMA) memory as a SAS
System cache.

MEMLIB
specifies to use Extended Server Memory Architecture (ESMA) memory as an
in-memory library.

MSGCASE
specifies whether notes, warnings, and error messages that are generated by SAS
are displayed in uppercase characters.

RESOURCELOC
specifies the directory location of the files that contain SAS resources.

SASINITIALFOLDER
specifies the current working folder and the default folder for the Open and Save
As dialog boxes.

SCROLLBARFLASH
specifies whether to allow scrollbars to receive keyboard focus.

SGIO
specifies to enable Scatter-read/Gather-write I/O processing.

SHORTFILEEXT
defines all SAS libraries to support three–character file extensions.

UNBUFLOG
specifies the log to be unbuffered.

The following SAS system options have been enhanced:

ENGINE
specifies the default access method for SAS data libraries. The valid values for the
engine-name argument were modified:

� the V8 engine was added as the current BASE engine

� the V7 engine was added to access Version 7 data sets.

� the V6 engine was added to access Release 6.04 and Release 6.08 through
Release 6.12 data sets.

CONFIG
specifies an alternative SAS configuration file. CONFIG may now be used multiple
times on the command line or within configuration files.

The following SAS system options no longer have details that are specific for
Windows:

CBUFNO

MSGLEVEL

NEWS

SYNCHIO

For more information about system options, see “SAS System Options under
Windows” on page 395.
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